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Excel  2000

Part 1
Excel is a spreadsheet program that allows you to perform both simple and complex calculations; filter data from a database or spreadsheet list; or chart data in a variety of formats.

Elements of the Excel Window

Title Bar 
The top horizontal bar that has the words ”Microsoft Excel” in it and the name of the current workbook (file).  You can have multiple workbooks open at once.

Menu Bar
The menu in Excel is consistent with the menus in Word.  You can also access many commonly used menu commands by clicking with the Right mouse button in any part of the spreadsheet.  

Toolbars
Toolbars contain buttons and drop-down menus to allow quick access to common functions.  Any Excel toolbar may be customized or you may create your own personalized toolbar from scratch.  

Formula Bar
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The Formula Bar is located directly below the toolbars and above the worksheet.  This is where you can enter text, labels, numbers, and formulas.  To the left of the formula bar is the Name Box.  The Name Box displays the name of the active cell or selected range and can be used to name a call or as a shortcut to access a named range.

Workbooks and Worksheets
Each Excel file consists of a Workbook that is a collection of individual sheets.  Sheets can help organize your work.  For example, one workbook may contain many related sheets.  The default workbook opens with 3 sheets named Sheet 1 through Sheet 3.  You may have up to 256 total sheets, if needed.   

A Worksheet is the area in which you do all of your work on a spreadsheet.  It is divided into columns and rows.  Each worksheet has 256 columns and 65,536 rows.  

The intersection of a row and column is a cell.  A cell is referenced by its column letter followed by its row number (e.g. A3) and can hold data in the form of numbers, text, or formulas.

The Active Cell is the current cell and is marked by a heavy black box in the worksheet.  Anything you type will be entered into the active cell.


A Range is a block of cells.  The first cell listed is the top left corner of the block and the second cell is the lower right.  Excel uses a colon to denote a range (example:  A3:C10). 
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Navigation Keys
Arrow  

Moves cursor one cell at a time in the direction of the arrow.

Home


Moves active cell to column A of the current row.

Ctrl-Home

Moves active cell to the first cell in the worksheet (A1).

Ctrl-End

Moves cursor to the last cell containing data in the sheet.

PgUp; PgDn

These will the cursor up or down one screen.

Alt-PgUp; PgDn     
Moves the cursor right or left one screen.

Ctrl-PgUp; PgDn    
Moves between sheets in the worksheet

Ctrl-Arrow

Moves the active cell in the direction of the arrow until the edge of a block of data is reached.

[F5] or Ctrl-G
Goes directly to a cell in the current sheet, another sheet, or another open workbook.  For example,   [Part1.xls]Sheet2!A26   would place the active cell in a Cell A26, of Sheet 2, in an Excel file named Part1. 
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1 |DeptA DeptB Total
2 100 400 500 (=A2+62)
3 200 100 300 (=A3+B3)



Ctrl-F


Searches the sheet for a specific value, text entry, or item in a formula; also accessible from Find in the Edit menu. 

Entering Data
You can type data directly into a cell by clicking on the cell to activate it.   Once you have type the information, you can: 

· press Enter to move the active cell to the next row in the same column (down one row);

· press Tab to move the active cell to the next column in the same row (to the right one cell); 
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press any one of the four Arrow Keys to move the active cell to the next cell in the direction of the arrow.

Note: if you wish to change the default action of the Enter key, go to Tools, Options, Edit and select the new default direction.

Sizing Columns and Rows
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To size a column or row, position the mouse pointer on the border between columns.  When you get the double headed arrow, drag the border of the cell to the desired position. You can also use the double-headed arrow to adjust a column automatically to the widest value by double clicking.
Autocomplete and Pick from List

With Autocomplete you can type a few letters or digits of an cell entry and Excel will automatically scan other values in the columns for a similar entry.  If it finds one, it will try to complete the entry for you. You can turn this feature off by choosing Tools, Options, Edit and click in the Enable Autocomplete for Cell Values checkbox.

Pick from List is similar.  When you enter a value in a cell and want to see which values have already been entered, right-click on the cell and choose Pick from List.

[image: image10.bmp]
Editing Data    
·  To edit the contents of a cell, double click on the cell to switch to Edit mode.

·  To remove the contents of a cell, click on the cell, and press the Delete key.

·  To undo or redo the last actions, click on the Undo or Redo buttons.  Use the drop down arrows to see a list of actions that can be undone.
Types of Information in a Cell

Label

Usually alphabetic characters (text).  Default alignment for text is left-aligned.

Value

A number or formula.  Anything that begins with a number or is preceded by certain symbols (=, +, ., -, $) is considered a value.  Default alignment for values is right-aligned.

Formula  A formula is an equation that performs operations on worksheet data. Formulas can perform mathematical operations, such as addition and multiplication, or they can compare worksheet values or join text. Formulas can refer to other cells on the same worksheet, cells on other sheets in the same workbook, or cells on sheets in other workbooks.

Formulas must start with an “=” sign.

Examples:    =g13*.05    =sum(b1:b24) 
=A3-B7     =(a1+b1)/c3
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Relative -- If you move the cells to another place in spreadsheet (or copy a formula from one location to another) cell references adjust accordingly.  For example, if you copy the formula from cell C2 to cell C3, the formula adjusts relative to the physical location of the cells in the original formula.

Absolute--If you don't want to adjust cell references when you copy a formula, refer to the specific location of the cell(s) in the formula by making them absolute.  To make a location absolute, insert a dollar sign ($) in front of the cell address.  For example:

    $A$4    $D3   H$20

Entering Formulas
You can either type formulas or use a point and click method.  To enter a formula:

1) 
Select the cell in which you want to enter the formula.

2)  Type an equal sign (=) to activate the formula bar.

3) Insert references into your formula by selecting cells on your worksheet.  When you 



select cells, Excel inserts relative references in your formula.

Developing a Worksheet
	
	A
	B
	C
	D
	E
	
	O



	1
	
	
	Expected % Increase:
	10%
	
	
	

	2
	
	
	
	
	
	
	

	3
	
	
	
	
	
	
	

	4
	
	
	
	
	
	
	

	5
	
	
	Jan
	Feb
	March
	
	Total

	6
	Sales
	
	100
	=C6+(C6*$D$1)
	=D6+(D6*$D$1)
	
	=sum(C6:N6)

	7
	Expenses
	
	=.6*C6
	=.6*D6
	=.6*E6
	
	=sum(C7:N7)

	8
	Profits
	
	=C6-C7
	=D6-D7
	=E6-E7
	
	=sum(C8:N8)


Selecting Cells, Rows and Columns

Before you can format a cell or group of cells, you will need to select them first.  Also, to add or delete columns or rows, you will need to select the number of columns or rows you wish to add or delete, first.

Below are the selection techniques that you will use in Excel.

Cell
Click on a cell to select it.

Range
Drag diagonally from the last cell to the first cell.  Or, click on the first cell and shift+click on the last cell.

Row/Column
Click the row or column heading.

All Cells
Click the Select All button (where column and row headings intersect).

Non-adjacent Cells
Select the first range and then hold down the CTRL key as you select 



additional cells/ranges.
Insert/Delete a Row or Column
To insert a row or column, select the same number of rows or columns you wish to insert, either above (rows) or to the left (columns).  Right-click on the selection to display a menu and choose Insert or Delete.  If you prefer, you can use the Insert menu, choosing Rows, Columns, or Cells.  

Rows are inserted above the row you are currently on.  Everything below will be moved down.  Columns are inserted to the left of the column you are currently in.  Everything to the right will be moved over.  

To delete a row(s) or column(s), click anywhere in the row or column and choose Edit, Delete.
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AutoFill
Autofill is a tool that allows you to create a series of fixed or incremental values on a worksheet by dragging the fill handle (the small plus sign on the bottom, right corner of the selection) with the mouse.  Click and drag to AutoFill consecutive cells.
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Copying/Moving

You can cut or copy cells from one location to another.  To cut or copy:

11 Select the cells to cut or copy;

12 Choose Cut or Copy from the Edit menu;

13 Position the cursor where you would like to paste the cells;

14 Choose Paste from the Edit menu.

Alternatively, you can use the Cut, Copy, Paste buttons from the toolbar or use the Windows shortcut keys: Cut <CTRL X>; Copy <CTRL C> or Paste <CTRL V>

Drag and Drop

Drag and Drop is a quick alternative for moving and copying data short distances.  

1) Select the data to move or copy (one or more cells);

2) Place the mouse pointer on the border of the selection;

3) Holding the left mouse button down, drag the cell(s) to a new location.

To copy, rather than move, data while dragging, hold down the CTRL key while performing step #3 above.
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AutoSum
The AutoSum function is a shortcut to typing  =sum(cell1:cell2), e.g., =sum(a4:a20).  Click on the cell where the sum is to be placed, and press the AutoSum button on the Toolbar.  Excel types the sum function and suggests the range of cells you want to add.  If the suggested range is incorrect, drag through the correct range and press the Enter key to accept the completed formula.  To sum both rows and columns, select a range that includes empty cells on the side and bottom to receive the total values.  

Formatting Tools
To apply formatting to any cell(s), rows or columns, use the selection techniques as described above.  Then click on any of the formatting buttons to apply formatting to those cells.
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Font and Font Sizes  
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Bold, Italic, Underline
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Alignment Tools 

Number Tools

Borders, Shading and Font Color  
Saving Your Worksheet

File, Save

If you have already saved the current worksheet once, then the Save option saves the current file to the same name as before, no questions asked.  If you have never saved the current worksheet, selecting this option brings up the Save As dialog box.

File, Save As

Save As always prompts you for a file name and destination. [Excel will attach a .XLS extension to the filename.]  Through Save As you can change the name of the current worksheet or save the worksheet in a different format.  For example, to save a worksheet in an ASCII file (text) format, with the file open, choose File, Save As and select one of the "Text" file formats from the  List Types of Files box.


File, Save Workspace
You can open a group of workbooks in one step if you first save them as a workspace file. Workspace files save the workbooks you have open, including their locations, window sizes, arrangement, and position on the screen. The size and position of the application window is saved every time you quit Microsoft Excel.

Once you have saved a workspace file, you can open the workspace and all of your workbooks will be displayed in the position you had them.







Active Cell








